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Introduction
Molecular cloning, the manipulation of DNA 
fragments to generate recombinant DNA that can 
be replicated within a host organism, is a technique 
that has revolutionized biological research and 
medicine. It was the discovery and isolation of 
various bacterial enzymes including restriction 
endonucleases in the 1950’s and 1960’s that 
propelled the beginnings of molecular cloning.1 
Further development of innovative technologies 
such as Polymerase Chain Reaction (PCR) have  
also contributed to advancements in molecular 
cloning techniques.2

Today, researchers have at their disposal a myriad 
of sophisticated, simple, and specialized cloning 
techniques that have many different applications 
including the study of gene and protein function 
and expression, clinical applications such as the 
discovery of therapeutic targets to treat disease 
and development of improved vaccines, and 
generation of transgenic organisms. 

Cloning requires multiple experimental steps  
that can be summarized in the Plasmid Cloning 
Cycle as follows:

1. Manipulation of DNA (isolation of insert, 
cutting of the vector, and ligation)

2. Transformation of DNA into bacterial host

3. Selection and Screening for candidate 
recombinant molecules

4. Extraction of candidate recombinant 
molecules from bacteria

5. Analysis of candidate recombinant molecules

In traditional cloning, the insert is isolated using 
restriction enzymes that cleave DNA at specific 
sites from genomic DNA, a plasmid or a fragment. 
The same restriction enzymes are used to cut the 
vector, facilitating ligation of the insert and vector. 
The characteristics of the vector, insert, and host 
organism, as well as the downstream application 
must be carefully considered to generate a 
successful cloning strategy. 

Since the birth of molecular cloning, many different 
and incredibly efficient cloning methods have  
been generated. Some of these techniques do not 
require restriction enzymes, can be performed 
in a few steps, and can be used to clone very 
large fragments of DNA. For example, instead of 
restriction enzymes, Gibson Assembly utilizes 
exonuclease, polymerase, and DNA ligase activities 
to join PCR-amplified fragments. 

Along with advances in cloning techniques, tools, 
such as SnapGene’s advanced software, have been 
developed to facilitate the cloning process. In this 
SnapGene Cloning Ebook, you will learn the basics 
of molecular cloning in Chapter 1. In Chapter 2, we 
explain the Plasmid Cloning Cycle and in Chapter 3 
you can explore the array of tools SnapGene offers 
that will simplify the Plasmid Cloning Cycle, including 
documentation and annotation tools. In Chapter 3 
you will also find how SnapGene helps create maps of 
your sequence’s features, digitally manipulate DNA to 
visualize your cloning strategy, and facilitate analysis 
of your clone. Chapter 4 contains general cloning 
tips. In Chapter 5, we illustrate how SnapGene can 
facilitate key cloning techniques including Restriction 
Enzyme Cloning, Gateway Cloning, Gibson Assembly, 
In-Fusion Cloning, and TA Cloning.
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Introduction to  
Molecular Cloning

Molecular cloning refers to the capture 
and isolation of a unique nucleic acid 
fragment (insert) so that it can be grown 
and propagated away from the genome 
it originated from. Once isolated, the 
fragment cannot be propagated until it 
has been transferred into a DNA cloning 
vector, which is a plasmid/virus that 
can transport the fragment into a host 
organism (cell) and assist in isolating or 
expressing the nucleic acid fragment.3 
The mixing of genetic material that 
occurs during cloning is described as 

“recombinant DNA.”

The general molecular cloning process 
is illustrated below (Figure 1). The DNA 
cloning vector/plasmid (in yellow) and 
a genome (in blue) containing the DNA 
fragment of interest (in red) are cleaved 
with restriction endonucleases, resulting 
in isolation of the DNA fragment, which  
can then be introduced (ligated) to the  
DNA vector. The DNA vector containing 
the DNA fragment is called a “recombinant  
molecule” (or recombinant DNA) and  
can be transferred into a bacterial  
host that can produce many copies  
of recombinant DNA.

1

Figure 1. Molecular cloning process. 
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Features of a DNA Vector
The most common type of DNA vector  
is a bacterial plasmid, which is a small  
circular piece of DNA that grows in  
bacteria, independent from the bacterial  
chromosome. Plasmids have multiple 
features that facilitate the cloning 
process. These key features include 
enzyme restriction sites, an E. coli origin  
of replication, antibiotic resistance 
genes and a multi-cloning site (MCS). 
On a plasmid map, the name of the 
plasmid and the base pair length is 
indicated in the center of the plasmid. 

Some of the most well-known plasmids 
are pBR322 and pUC19. We will use 
pBR322and pUC19 to illustrate the 
location and function of each of  
these key features. 

CHAPTER 1

Plasmids have multiple restriction sites 
(e.g., HindIII), which are indicated along 
the perimeter of the plasmid in the 
plasmid map. These restriction sites are 
recognized by restriction enzymes that 
cleave DNA at this site and are essential 
for specific cloning methods. 

Another key feature is the “ori” or E. coli 
origin of replication (in yellow), which 
allows the plasmid to be replicated 
by E. coli’s DNA replication machinery, 
independently of the bacterial genome.4

Plasmids also have antibiotic resistance 
genes. pbR322, for example, has 
ampicillin and tetracycline resistance 
genes (green arrows), which also have 
associated promoters (white arrow). 
These resistance genes allow for 
selection of plasmids. Expression of 
the proteins encoded by either of the 
resistance genes protect the bacteria. 
The bacteria that do not contain this 
plasmid die when exposed to ampicillin 
or tetracycline. However, if the bacteria 
contain intact pBR322, they will 
survive. These resistance genes are 
called selectable markers. The type 
of selectable marker depends on the 
organism that the plasmid is intended 
to work with. 

Figure 2. Map of E. coli plasmid pBR322.
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CHAPTER 1

One important universal feature 
that has been added to plasmids 
is the MCS, which is a polylinker 
that contains several restriction 
sites that makes cloning easier by 
creating more flexibility in how DNA 
fragments can be inserted into a 
plasmid without disrupting essential 
elements of the plasmid. In pUC19 
for example, the MCS is indicated in 
blue (Figure 3) and contains a cluster 
of restriction enzymes that you can 
use when cloning into this plasmid.5 
Note that the ampicillin resistance 
gene (AmpR) in green and the E. coli 
origin of replication (Ori) in yellow 
contain enzyme restriction sites. The 
use of these enzyme restriction sites 
may result in disruption of antibiotic 
resistance or replication, which could 
affect your cloning results. Thus, it is 
very important that the restriction 
sites that will be used in the cloning 
procedure be carefully selected. 

SnapGene, a leading cloning tool 
preferred by scientists, has many 
functional features that aid in the 
cloning process. With SnapGene, the 
restriction sites that appear only once 
in a given sequence will be bolded as 
seen below (Figure 4) and there is an 
Enzyme Selection window where you 
can choose unique restriction sites, 
to ensure you are only cutting your 
plasmid at the site of interest.. You can 
learn about this tool here (link video). 

Figure 3. pUC19 plasmid.

Figure 4. Enzyme restriction sites in pUC19.
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Scientists use different model 
organisms for biological research. 
These organisms include mice, 
zebrafish, frogs, and yeast 
(Figure 5). Because the biology 
of these organisms varies vastly, 
specific and dedicated plasmids 
are needed to perform cloning 
and research in each unique 
organism. In other words, each 
organism requires vectors that 
contain features that allow their 
replication and gene expression 
in the model organism. 

These organism specific 
functional elements, include: 
origins of replication, 
promoters and selectable 
markers. The sequences 
of commonly used vectors 
are available directly from 
SnapGene’s website.

CHAPTER 1

Figure 5. Organisms commonly used in biological research.

Visit SnapGene.com to learn more about cloning  
and ensure successful generation of recombinant  

DNA during your cloning experiments.
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Introduction to the 
Plasmid Cloning Cycle 

To successfully perform a cloning 
experiment, you must first understand 
how the different phases of cloning 
work. Here, we take you through the 
plasmid cloning cycle to illustrate the 
different phases of molecular cloning. 

A series of steps must be performed 
successfully and in a specific order to 
clone a DNA fragment of interest into 
a cloning vector (plasmid). These steps 
are as follows:

1. Manipulation of DNA  
(isolation of insert, cutting  
of the vector, and ligation)

2. Transformation of DNA into 
bacterial host

3. Selection and Screening  
for candidate recombinant 
molecules

4. Extraction of candidate 
recombinant molecules  
from bacteria

5. Analysis of candidate  
recombinant molecules 

Depending on the type of cloning 
experiment, you may need to perform 
this cycle one time. More complex cloning 
experiments may require that you 
perform this cycle of steps multiple times. 

2

Figure 6. An overview of the plasmid cloning cycle.
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Step 1: Manipulation of DNA
The first step is to manipulate DNA with the goal 
of generating a novel recombinant DNA molecule 
using specific starting materials (Figure 7). These 
starting materials include the intact cloning vector/ 
plasmid (seen below in yellow), which is needed 
to help propagate the DNA of interest in a specific 
host, and the DNA fragment of interest (seen here 
in red), which is found in genomic DNA/Eukaryotic 
chromosome (in blue). The DNA material in red is 
the fragment that is to be isolated and cloned into 
the vector/plasmid. 

CHAPTER 2

Figure 7. Starting material for the cloning procedure. 

Figure 8. Manipulation of DNA. Genomic DNA and the plasmid 
are cut separately with the same restriction enzymes. Ligase 
is used to generate the recombinant vector.

The classic approach to manipulate the plasmid 
and isolate the fragment of interest uses restriction 
enzymes. Restriction enzymes can be described 
as molecular scissors that cut DNA at specific 
sequences. It is also possible to manipulate DNA 
without restriction enzymes (this will be discussed 
later on). 

A plasmid that is cut with restriction enzymes 
becomes linear. When the plasmid and DNA fragment 
are cut with the same restriction enzymes, they can 
be ligated back together using an enzyme called DNA 
ligase. The ligase “glues” fragments and the linearized 
plasmid together to generate a recombinant vector— 
a functional circular plasmid (Figure 8). 

Ligation does not guarantee that the DNA of interest  
has been ligated to the plasmid correctly. Analysis 
of your resulting clones is necessary to confirm that  
your cloning procedure has worked. This analysis 
will be covered in the Clone Verification section. 

Once ligation occurs and recombinant DNA has been 
generated—and before clones can be analyzed—the 
recombinant DNA must be introduced into host cells.

Cloning vector (plasmid)

Eukaryotic chromosome

Manipulations of DNA.
Vector and insert fragments are prepared 
separately them recombined.

Recombinant Vector
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CHAPTER 2

Figure 9. Chemically competent cells 
allow attachment of plasmid DNA to 
the cell membrane. 

Step 2: Transformation
The DNA mixture can be introduced into bacterial 
cells through a process called transformation—a 
process that allows bacteria to make copies of the 
recombinant DNA. 

Bacteria are very useful for cloning because 
they are able to absorb genetic material from 
their environment. Scientists have optimized this 
process to facilitate cloning experiments. The 
most common transformation technique used in 
laboratories today uses chemically competent cells, 
which are cells that have been treated with calcium 
chloride to allow attachment of plasmid DNA to the 
competent cell membrane (Figure 9). Bacteria are very useful for 

cloning because they are able 
to absorb genetic material 
from their environment.
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Another technique uses electroporation, which 
involves exposing the cells to an electrical field  
(a shock), which increases the permeability of the 
cell membrane and allows plasmids to enter the 
cell. (Tylewicz).

With either technique, chemical transformation or 
electroporation, a very small proportion of cells 
are induced to take DNA from the surrounding 
environment. This is where the selectable marker 
on the DNA vector comes into play. 
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Step 3a: Selection  
(no cap required)
Once the plasmid has been introduced 
into the competent bacteria, the bacteria  
are allowed to rest and are then plated 
on agar plates so they can grow and 
propagate. In a process known as 
Selection, only the cells that received 
the circularized plasmid during 
transformation will grow (Figure 10). 

CHAPTER 2

Figure 10. Bacterial colonies that are antibiotic 
resistant grow in an agar plate. 

Figure 11. Propagation of bacteria during Selection.

This selective growth is caused by 
the plasmids containing an antibiotic 
resistance gene that when expressed 
allows the bacteria to grow in media 
containing antibiotics (Figure 11).

As mentioned previously, there are 
three types of plasmids that can result 
from cloning:

1. The vector can re-ligate back to 
itself (plasmid with no insert).

2. A blue fragment (not the DNA of 
interest) can ligate into the vector 
(plasmid with wrong insert).

3. A red fragment (DNA of interest) 
can ligate into the vector (plasmid 
with correct insert). 

All of these plasmids will promote 
growth of bacteria in the presence of 
antibiotics. There may be several or 
just a few desired clones growing in 
the agar plates. Thus, the next step is 
to determine which clones contain the 
correct insert by performing a blue-
white screen. 
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Step 3b: Screening 
Screening (no cap required)
Screening is distinct from Selection in that in 
Screening bacteria are examined for a specific 
phenotype. Blue-white screening is a very common 
screening technique, where the bacteria will 
appear blue or white depending on the presence 
of a plasmid. Other model systems rely on other 
phenotypes in their screening protocols. 

Blue-white screening is possible due to the plasmid 
containing a specific functional feature—LacZα. 
When LacZα is disrupted by cloning into the MCS, 
then B-galactosidase cannot be produced and 
the bacteria cannot turn bright blue, the bacteria 
appear white (Figure 12). This is a very common 
screen and almost all plasmids carry the LacZα 
fragment. Depending on your cloning strategy,  
you may not need to perform this screen. 

A white colony will appear when the insert has 
disrupted the MCS, and associated LacZ alpha 
fragment. There is no insert, colonies will remain 
blue (Figure 13). 

For example, after insertion of the GFP-coding 
sequence (Figure 14) into pUC19, B-galactosidase 
cannot be produced and the bacteria will not turn 
bright blue. 

Thus, when cloning GFP into pUC19, the starting 
materials are vector (pUC19) and the fragment of 
interest (GFP). We would be cloning a GFP fragment 
into the vector pUC19 using restriction enzymes 
to cut at restriction sites in the MCS of pUC19 
and restriction sites in the insert (GFP). Once the 
fragments are cleaned up, they can be joined with 
ligase. The resulting DNA construct will be used 
to transform bacteria. Then, ampicillin selection 
and blue-white screening will be used to grow the 
bacteria and screen for colonies. 

Figure 12. Blue and white colonies for a Blue-White screen. 

Figure 13. LacZα sequence in pUC19, indicated in purple.

Figure 14. Cloning of the GFP sequence into the MCS  
disrupts LacZα.

CHAPTER 2
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Step 4: Extraction from Bacteria
Once candidate clones are identified, small 
bacterial cultures are inoculated so that DNA can 
be extracted for analysis. DNA is extracted using 
a DNA miniprep, which is a rapid minipreparation 
of plasmid DNA. It is called a “mini” prep because 
it allows for isolation of small amounts of plasmid 

CHAPTER 2

Step 5: Clone Verification 
After isolation of the DNA, you must verify which 
clone (or clones) are the desired clone. There are 
multiple approaches to determine which clones are 
the correct ones. 

One approach is sequencing, a method that is very 
accurate and yields sequences as shown below. 
A clone can be easily validated by aligning the 
sequence of the clone to a reference sequence, 
using SnapGene Tools.

Restriction digest is another approach, and it 
requires the use of different restriction enzymes to 
cut the plasmid DNA at different sites. If your clone 
is the correct one, the resulting fragments will 
show that the insert is the correct and expected 
size (Figure 16). Another option is a diagnostic PCR 
reaction. It is important that you are 100 percent 
sure that your clone is the correct one before 
proceeding to the next step of your experiment. 

To summarize, the materials and steps required for 
cloning a fragment of interest (GFP) into a plasmid 
(pUC19) are the following:

Figure 15. Sample sequence that is given once a clone is 
submitted for sequencing.

Figure 16. Restriction digests of plasmid DNA. 

DNA—usually it yields around 30 micrograms of 
DNA. Currently, there are many DNA mini-prep 
kits available on the market that you can use. 
Once purified, DNA can be analyzed to determine 
whether the fragment of interest has been cloned 
as planned. 

1. Manipulation of DNA

Vector
Fragment of Interest

2. Transformation

3. Bacterial Growth

4. Extraction of DNA

5. Clone verification

Starting Material pUC19
GFP SnapGene

Treatment with restriction 
enzymes and ligase

Transform bacteria with 
DNA mixture

Standard miniprep 
procedure

Ampicillin Selection
Blue/white screening

Sequencing, PCR, digest

Lab bench
SnapGene

Lab bench
SnapGene

Lab bench

Lab bench

Lab bench
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Visit SnapGene.com to learn more about cloning 
and ensure successful generation of recombinant 

DNA during your cloning experiments. 

CHAPTER 2

Depending on your cloning objective, you may 
proceed through steps 1 through 5 just once before 
proceeding with other aspects of your experiment. 
Other situations may require that you “cycle” 
through the steps until your project is complete. 
Thus we can represent the steps of the Cloning 
Cycle in a flow chart.

The decision points come after analyzing candidate 
clones for completeness and accuracy.

Do you have an 
accurate clone?

Is it your finished 
product?

End

YES!

YES!NO!

NO!

Start

Transform Bacteria

Screening/Selection

Extraction of DNA (miniprep)

Analysis of cloning products

Manipulate DNA

1. The clone is not correct. Thus, you must
start over at the manipulation of DNA-step.
Troubleshooting may be needed.

2. The clone is correct but further modification
is needed. Thus, you will manipulate the
DNA again.

3. The clone is correct and is the desired finished
product. In this case, you can proceed to other
aspects of the experiment.
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How SnapGene  
helps with the  
Plasmid Cloning Cycle

3

SnapGene has many different tools that 
will help with your cloning workflow. 
Here, we described how different 
SnapGene tools can be used throughout 
the Cloning Cycle (shown below). 

In order to successfully create a 
molecular clone, you need to understand 
the features of the genetic material you 
are starting with. You also need a clear 
idea of how you will use those features 
in your completed construct. SnapGene 
Tools allow you to virtually assemble 
your final construct before proceeding 
to the bench. Visualizing your clone 
this way, before proceeding, allows to 
guarantee that you will be including all 
the elements that you need, and that 
they are positioned correctly.

Using SnapGene to Document 
and Annotate Sequences 
In general, when starting a cloning experiment you must 
first document the sequence. In SnapGene, the functions 
for creating DNA files and documenting them are found 
in the File Menu. SnapGene allows you to create a new 
sequence or import a sequence from another format 
(Figure 17). This is especially helpful because you may 
receive sequences from different sources that use 
different formats. 

Figure 17. Creating a new sequence in SnapGene. 

SnapGene has many 
different tools that will 
help with your cloning 
workflow.
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Your sequence may come fully 
annotated or may need to be analyzed 
and annotated. In SnapGene, most of 
the annotating tools can be found in 
three menus: Enzymes, Features, and 
Primers (Figure 18).

It must be noted that prior to 
proceeding you must verify that you 
have received the correct plasmid. 
You must sequence at least part of 
the plasmid to determine whether it 
is the correct sequence. This is a very 
important step of cloning because it 
determines whether your experiment 
is successful or not. In SnapGene, you 
can easily align your cloned (original) 
sequence with one or more reference 
sequences. This function can be done 
using the Tools menu, where you can 
choose to align your sequence with 
other sequences, a copied sequence,  
or a sequence trace. You can see exactly 
how your original sequence matches  
to different reference sequences  
(Figure 19). 

For more details about how to align 
sequences, check out this SnapGene 
video tutorial. 

CHAPTER 3

Figure 18. Annotating in SnapGene.

Figure 19. Aligning sequences in SnapGene for cloning verification. 

To learn more about how to use Features 
in SnapGene watch this video tutorial.

The Plasmid Cloning Cycle 15

https://www.snapgene.com/resources/getting-started/#working-with-features
https://www.snapgene.com/resources/getting-started/#working-with-features
https://www.snapgene.com/resources/getting-started/#alignment


Using SnapGene Actions for Your Cloning 
Strategy and Molecular Construct 

Figure 20. Action menu in SnapGene.

insertion of fragments into a desired 
plasmid and visualize the process 
from beginning to end. Throughout the 
cloning process, SnapGene allows you 
to see specific elements of the plasmid 
(e.g., restriction sites, MCS, antibiotic 
resistance genes). 

The cloning techniques that SnapGene 
allows you to visualize include 
Restriction and Insertion Cloning, 
Gateway Cloning, Gibson and HiFi 
Assembly, and InFusion Cloning.  
These are discussed in more detail  
in Chapter 5. 

Once you develop your cloning  
strategy and visualize the resulting 
construct using SnapGene, you can 
move to the bench and perform the 
necessary procedures: cutting with 
restriction enzymes, transformation, 
growing of bacterial cultures, and 
extraction of DNA. 

CHAPTER 3

The SnapGene Actions menu contains 
an array of tools that allow you to 
design and plan your cloning project 
in silico, allowing you to prepare for 
manipulation of DNA at the bench 
(Figure 20). This is a very useful tool 
because it allows you to simulate 

With SnapGene, you can visualize the map, sequence, primers, and history 
of steps, which is very helpful when performing a cloning simulation
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CHAPTER 3

Using SnapGene Tools to Verify Your Clone
Thus, you can use SnapGene functions to facilitate 
your cloning project (Figure 22):

Figure 21. Simulate Agarose Gel function in Tools in SnapGene.

Figure 22. SnapGene functions useful for the Cloning Cycle.

Under the Tools menu, you can access NCBI 
searches as well as local sequence assembly 
and alignment functions to help validate your 
molecular clone. 

1. The File menu allows you to create documents.

2. The Enzyme, Features, and Primers drop down
menus allow you to add custom annotations
to your sequences so that you can create
a complete map of the features that are
important in your sequences.

3. The Actions menu allows for digital
manipulation of DNA.

4. The Tools menu including the Agarose Gel
Simulator facilitates analysis of your clone.

The functions of SnapGene ‘Tools’ are essential for 
clone verification. You may need to use a combination 
of Assemble or Align depending on the sequence 
you are analyzing. SnapGene’s Simulate Agarose Gel 
can be used to predict your results when you are 
analyzing your clones with a diagnostic PCR reaction 
or a restriction digest. 

Visit SnapGene.com to learn more about the  
different tools that will make your cloning possible. 

1. Manipulation of DNA

Vector
Fragment of Interest

2. Transformation

3. Bacterial Growth

4. Extraction of DNA

5. Clone verification

Starting Material
Lab Bench SnapGene

Various enzymes

Use of bacteria

Minipreps

Use of selective media

Sequence or 
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Manipulate digitally 
in Actions

Analyze and compare in 
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n/a

n/a

n/a
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4
General Tips for 
Cloning Success

Here, we present general tips that will 
help you achieve cloning success. 

Tip 1. Respect Murphy’s Law

If anything can go wrong, it will. 
However, by following the tips shared 
here you may avoid the many issues 
that may arise during cloning. 

Tip 2. Understand the protocols  
and learn why each step is needed.

It is essential that when starting to use 
a cloning protocol, you understand what 
each step in the protocol accomplishes. 
As you become more familiar with the 
protocol and technique, you will learn 
which steps require more attention and 
precision, and which steps allow for 
more flexibility. 

In some instances, you may increase 
efficiency by spending time choosing 
the best approach. For example, it is 
more efficient to clone a blunt-ended 
fragment into a blunt vector site, than 
into a site that has been blunted with 
Klenow or T4 DNA polymerase. 

Tip 3. Prepare abundant and 
high-quality nucleic acids. 

There is no substitute for good starting 
material with few contaminants. To 
obtain good-quality and abundant DNA, 
you must follow the DNA purification 
procedures carefully. Remember that 
it is easier to dilute something than to 
concentrate it. The quality of DNA is 
important. Thus, you must ensure that 
the DNA is clean. 

Tip 4. Accurately quantitate your 
nucleic acids. 

Ensure that you are quantifying small 
volumes of DNA accurately. Well-purified 
DNA has a characteristic curve over the 
measured UV spectrum. A sample of 
a classic UV spectrum observed on a 
NanoDrop instrument is shown on Figure 
23. Absorbance at 260 nanometers is
used to quantitate DNA. Quality of DNA
is indicated by the 260/280 ratio. DNA
with good purity will have a 260/280
ratio of 1.80-2.00. As seen below, the
DNA is of good quality—which is also
indicated by the shape of the curve.
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A sample that has impurities will not have the peak 
shown above. Impurities can inhibit a downstream 
reaction. Impurities also interfere with accurate 
quantification of nucleic acids. It is also preferred 
to use samples that have less contaminants. 

Tip 5. Carefully store and handle DNA

Freeze DNA to protect it from UV and oxidative 
damage. Avoid prolonged exposure to shortwave 
UV (UVB) when purifying DNA from agarose gel. Use 
the longer wavelength UV option (UVA). It would be 
best to use a non-UV lamp with the appropriate 
dye to avoid damaging DNA. 

Tip 6. Understand molar ratios

Many protocols indicate the molar ratios needed. 
Thus, you must understand moral ratios. Specifically, 
you must understand the relationship between DNA 
mass and molar concentration. The mass of a DNA 
molecule is directly proportional to its length. 

This example from SnapGene DNA calculations shows 
information about two different DNA molecules; 
pUC19 and M13/pUC Reverse (Figure 24). Full length 
pUC19 is 2,686 base pairs long and its molecular 
weight is 1.66 x 10^6 Daltons. The second fragment, 

M13/pUC Reverse, is a small oligonucleotide (primer) 
that is used for sequencing. Its molecular weight is 
7,065.7 Daltons. As shown below, 1 nanomole of primer 
weighs 7.066 micrograms, whereas 1 nanomole of 
pUC19 weighs 1.659 milligrams. If these two fragments 
were mixed together based solely on their mass, we 
would have over 200x more moles of primer than of 
the plasmid, which may or may not be ideal. For most 
cloning experiments, insert to vector ratios will vary. 
Some protocols may call for 2:1 to 5:1 insert to vector 
ratio. The optimal molar ratio depends on the sizes of 
the fragments and the specific technique that is used. 

CHAPTER 4

Figure 23. Sample quantification of DNA using a NanoDrop. 

Figure 24. DNA calculation sample from SnapGene.

For more restriction 
cloning tips visit this 
SnapGene Resource.
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Tip 7. Learn to pipette as accurately as possible. 

The less deviation you can introduce via pipetting 
the better. Accurate pipetting leads to accurate 
measurements and strong replicates. 

Tip 8. Double check your work

For molecular biology experiments and cloning, it is 
important that you double check your calculations. 
In addition, learn what different volumes look like 
in your pipettors and Eppendorf tubes, and double 
check your labels. 

Tip 9. Save your reaction intermediates

Saving reaction intermediates during cloning 
is beneficial when unexpected mishaps occur. 
Saving leftovers from reactions allows you to 
repeat steps if necessary. For example, you 
may have made a mistake when performing the 
transformation protocol. If you saved part of the 
ligation reaction, you can go back and repeat the 
transformation as needed. 
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Tip 10. Safely store and accurately 
document your finished products

Most reagents have optimal storage conditions. 
If these guidelines are not followed, then the 
materials will degrade, resulting failure of your 
experiment and wasted time and money. 

Tip 11. Do not depend on kits

Kits are very useful, only when you understand 
what each step accomplishes. This is especially 
important when kits fail. Your understanding of 
the procedure will allow you to effectively 
troubleshoot the problem. 

Tip 12. Simplify your cloning 

If possible, minimize the steps in your cloning 
protocol. As more steps are involved, there is a 
higher chance for error, loss of yield, mis-labeling, 
and mutation. 

Visit SnapGene.com to learn more about cloning 
and ensure successful generation of recombinant 

DNA during your cloning experiments.
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5
SnapGene’s Key  
Cloning Techniques

SnapGene offers a wide range of user-friendly tools 
that support and facilitate simple and complex 
cloning projects. With SnapGene you can plan 
your cloning strategy, visualize the process, and 
document your work. SnapGene’s tools prevent you 
from making errors and wasting time at the bench. 

SnapGene helps streamline your cloning:

1. Specialized cloning tools ensure fast accurate
construct design for all major molecular
cloning techniques

2. Highly visual alignment of sequencing results
to your simulated construct and simulation of
agarose gel electrophoresis ensure accurate
verification of your cloning results

3. Automatic documentation tools record
your experimental procedures and create a
graphical history

4. Data management tools allow storage,
importing, sharing, and the organization
of maps, files and sequences

Restriction Enzyme Cloning 
Restriction enzyme cloning is a common technique 
that is used to prepare inserts and vectors for 
cloning using restriction enzymes. This method is 
used mainly when the insert and vector contain 
compatible restriction sites—the restriction sites 
must flank the region of interest and ideally be 
found within the MCS of the plasmid. In SnapGene, 
you can simulate cutting and ligation of plasmid 
and insert (Figure 25). In a few easy steps, you can 
import (or use copy/paste functions in SnapGene) 
sequences, cut them, and ligate them. You can then 
preview the final cloned plasmid, which will show 
the insert in red and the plasmid in black. You can 
see the step-by-step process here.

Figure 25. Simulation and visualization of restriction enzyme 
cloning in SnapGene. 
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Gateway Cloning
Gateway cloning is a highly 
efficient alternative to traditional 
restriction enzyme cloning and 
does not require restriction 
enzymes to insert DNA into a 
plasmid. Instead, an insert is 
moved into a vector through 
a two-step recombination 
process that takes advantage 
of integration and excision 
reactions using attachment sites 
attL and attB. The first step—a BP 
reaction—creates an entry clone 
containing the DNA insert flanked 
by two attL sites. The second 
step—an LR reaction—creates an 
expression clone containing the 
DNA insert flanked by two attB 
sites. Multisite Gateway cloning 
allows up to four fragments to  
be inserted simultaneously.

Below, you can see how SnapGene 
visualizes both reactions including 
the insert fragment and donor 
vector, which are needed for 
the BP reaction, as well as the 
resulting entry clone and the 
destination vector, which are 
needed for the LR reaction 
(Figures 26 and 27). 

To learn more about SnapGene’s 
Gateway Cloning simulation  
click here.
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Figure 26. Creation of the entry clone using an insert sequence 
and a donor vector. 

Figure 27. SnapGene snapshot of the expression clone, the product, through 
the LR reaction which uses the entry clone and a destination vector.
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Gibson Assembly
Gibson Assembly is another efficient and 
easy-to-use cloning method that does not 
require restriction enzymes and allows 
insertion of multiple fragments into a 
plasmid in one reaction. 

SnapGene simplifies your Gibson 
Assembly cloning procedure by letting 
you select and visualize the desired 
vector and fragments. SnapGene has 
automated primer design (Sidebar: After 
you design your primers on SnapGene, 
you can export them, which facilitates 
the primer ordering process) so that your 
fragments contain the overlaps needed for 
Gibson Assembly cloning (Figure 28). Below, 
Gibson Assembly was used to clone two 
fragments into a chosen vector.

See a detailed procedure for simulation 
of Gibson Assembly in SnapGene. 

In-Fusion Cloning
In-Fusion cloning is a very efficient 
cloning method that does not require 
ligation. The insert and linearized 
vector are joined by the annealing 
of complementary ends (flanking 
homologous overlaps), which are 
generated via PCR, in a single step using 
the In-Fusion enzyme. It is important to 
note that the vector must be linearized 
through restriction digest or inverse  
PCR. In general, In-Fusion cloning is 
faster and has higher accuracy than 
Gibson Assembly. 

In SnapGene, you can perform In-Fusion 
cloning by clicking on Actions In-Fusion 
Cloning Insert Fragment (Figures 29 and 30). 
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Figure 28. Product in SnapGene’s simulation of Gibson Assembly 
performed with a vector and two fragments. Primers are indicated in 
purple. The fragments are shown in blue and red. 

Figure 30. The product of In-Fusion Cloning simulation in SnapGene. 
The fragment is in red and the plasmid is in black. Primers are 
indicated in purple.

Figure 29. In SnapGene, In-Fusion cloning can be simulated 
using the Actions menu.
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Figure 31. Snapshot of SnapGene’s menu for TA and GC cloning 
simulation and visualization process. 

TA Cloning 
TA cloning is a simple cloning technique that does 
not require restriction enzymes. Instead, these 
techniques utilize the addition of A overhangs to 
the 3’ end of PCR products by DNA polymerase 
enabling ligation of these PCR products into 
vectors with complementary T overhangs. 

In SnapGene, you can simulate TA cloning by clicking 
on Actions > TA or GC Cloning. Below you will see the 
drop down menu in SnapGene (Figure 31). 
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As with other cloning techniques, you can select 
the insert and linearized vector files (Sidebar: With 
SnapGene choose a custom vector or a commercially 
available vector). Once selected, you will design the 
suitable PCR primers. In the Product tab, you will be 
able to see the insert and linearized vector with their 
overhang sequences, which are also indicated in the 
product (Figure 32). The vector is indicated in black 
and the insert is indicated in red. 

Figure 32. Snapshot of simulation of TA cloning in SnapGene. The 
resulting product is a plasmid with the indicated insert (in red).

To learn more about the detailed steps to  
use these cloning techniques in SnapGene  
check out these SnapGene video tutorials. 
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